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IBM WebSphere Business Components (WSBC) Studio 
Version 1.1 
This document has the following sections  

• CD contents 

• Notes 

• Known limitations and issues 

This version of the Release Notes is based on information known at the time the CD for IBM WebSphere Business 
Components (WSBC) Studio Version 1.1 was created. For the latest updates to the Release Notes and Installation 
Guide, see ibm.com/software/components/support.html. 
The green text represents changes that were made to this document after the WebSphere Business Components 
Studio Version 1.1 CD was created. 
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CD contents 
The IBM WebSphere Business Components (WSBC) Studio Version 1.1 CD contains a set of Advanced 
Components, their supporting component-based architecture, tools, examples, samples, and documentation.  

The Advanced Components (ACs) are Customer Profile and Product Catalog. The Customer Profile AC manages 
customer information such as names as well as related information such as addresses and telephone numbers. The 
Product Catalog AC manages product information and provides a way of organizing and comparing products. The 
CD provides an implementation of each AC. 

Supporting the ACs is a service layer that provides services that are common to many ACs. The AC services 
included on this CD are AC Command service, AC Context service, AC Event service, AC Exception service, AC 
NLS service, and AC System Management service. The AC Command service provides the communication 
mechanism between Advanced Components and their clients while the AC Context service provides a mechanism to 
retain AC instance information throughout its lifetime. The AC Exception and AC Event services provide exception 
distribution and event notification services respectively. The AC NLS service provides a mechanism to distribute 
language-neutral information, which can then be formatted to a specific locale. The AC System Management service 
provides a mechanism to manage and maintain the system such as configuring ACs. 

To support the creation and deployment of components, the Studio CD provides the WSBC Code Generator and the 
AC Deployment Tool. The WSBC Code Generator uses Rational Rose models to generate the framework of a 
component according to a predefined template. The AC Deployment Tool automates part of the process of 
deploying an AC onto a Web server such as WebSphere.  

The Product Recommendation application included on the CD is an example of how to construct an application 
using ACs. This application uses the implementations of Customer Profile and Product Catalog provided on this CD. 

One of the advantages of using WebSphere Business Components is that they can work with existing systems and 
services. The CD provides several sample non-WSBC systems, components, and services (including several non-
Java components) that have been wrapped with an interface layer so that they can interact with WebSphere Business 
Components.  

The WSBC Studio CD contains an online information Web that can be installed. The online information contains 
descriptions and technical details of the components, the architecture within which they exist, the services within the 
AC Service layer, the example application, and the wrapping samples. The Studio documentation also includes these 
Release Notes and the Installation Guide. 
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Notes 
This section provides information that was not included in the online information.  

AC Deployment Tool sample files 
The WSBC Studio install includes three AC .jar files that you can use to view a sample of the input expected by the 
AC Deployment Tool. You can also use these files to practice using the AC Deployment Tool. These files are 
located in the tools/samples folder. 

Base Components 
The online information covers Base Components. However, the Studio Version 1.1 CD does not contain any Base 
Components. To obtain these components and the latest documentation for them, see the WebSphere Business 
Components Web site at ibm.com/software/components.  

Customer Profile 
The .bat file provided to create the Person tables for the Customer Profile AC specifies a size of 30 characters for the 
id columns. The default configuration specified by the ACImplementation.xml file is 40 characters. This difference 
results in an error when a user tries to create a Person customer because the AC is inputting a field that is too long . 
To correct this problem, edit the customerProfilePersonTables.bat file to increase the size of the id columns for each 
table. These sizes must be increased to 40.  

Documentation 

Javadoc 
Some of the Javadoc contained in the online information may have formatting errors and may not exactly match the 
code (and the comments in the code) delivered on the Version 1.1 CD.  

Search 
The search may return an error the first time it is used in a session. To correct this, perform a different search and 
then perform the original search again. 

Update to the WSBC Code Generator documentation 
The "Modeling Advanced Components" page of the online information for the WSBC Code Generator incorrectly 
indicates that Professional J 2000e edition is the recommended version of Rational Rose for modeling ACs. In fact, 
either of the following two versions is recommended: 

• Rose 2000e - Modeler edition 

• Rose 2000e - Enterprise edition 

Also in "Modeling Advanced Components", In the "Modeling Advanced Components" page of the online 
information for the WSBC Code Generator, the Interface Design and the Interface Models diagrams are from a 
hypothetical CustomerOrder AC and not from Offering AC as identified by the diagram labels.  
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Updates to Customer Profile documentation 
In the second paragraph of the use cases page of the online information for the Customer Profile AC, the reference 
to the Product Catalog AC is incorrect. The reference should be to the Customer Profile AC. The hyperlink in the 
sentence is correct.  

As the Customer Profile AC can be used in multiple industries and is not limited to the financial industry, the word 
"financial" should be deleted from the "Interface arguments" page of the Customer Profile AC online information. 

Updates to Product Catalog documentation 
In the Interactivity with other Components section, the diagram has an AC function interface called 
GetProductFromID. This AC function interface is replaced by one called GetProductForLocale. 

Updates to AC Deployment Tool documentation 

Menu options 
The documentation for the AC Deployment Tool refers incorrectly to AC Deployment Tool menu options. The 
document indicates that the following options are available:  

• Verify 

• Deploy 

• Undeploy 

The actual menu items on the AC Deployment Tool appear as follows:  

• Verify AC Instance 

• Deploy AC Instance 

• Undeploy AC Instance 

Run AC Deployment Tool as a standalone application 
Each time you run the AC Deployment Tool as a standalone application from the command line, you must run three 
.bat files in sequence. To do this, complete the following steps:  

1. Open a command prompt. 

2. Run the setupCmdLine.bat file found in the <WebSphereRoot>\AppServer\bin directory. 

3. Run setWSenv.bat. 

4. Run runDeploymentTool.bat. 

Load an AC .jar file 
The instructions describing how to load an AC .jar file should include a new first step, as follows:  

1. Copy the AC .jar file to a directory designated for deployment. 

By completing this step, you prevent the possibility of saving your deployment settings for the AC back to the 
location of the original .jar file. 
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Registered Name to JNDI name mapping  
The Function Group Registered Name field for a function group specifies the JNDI name of the AC's Session Bean. 
The Target Registered Name field for a function specifies the JNDI name of the AC Command Target Bean from 
AC Services. 

AC Configuration 
Where the AC Deployment Tool documentation refers to AC configuration, the intended meaning is the settings for 
the deployment of an AC instance. This is distinct from the meaning of AC configuration as a set of System 
Management values used to configure how the AC works at runtime.  

Update to AC Event service documentation 
The AC Event service resource bundle is ACEventConfiguration.properties, which is located in the 
com/ibm/wsbc/acs/event directory subtree. In the "Configure AC Event" page, the resource bundle is incorrectly 
indicated as com.ibm.wsbc.acs.event.ACEventConfiguration. 

Update to AC NLS service documentation 
The following information should appear in AC NLS References:  

• ACLocalizableTextImpl: The client using AC Command can use the initFromDomElement() method (not 
fromXML()) to generate the object back from the XML DOM element representing the localizable text 
XML.  

• AC NLS service uses LocalizableException internally, but you cannot specify a LocalizableException in 
NLS methods and if the localize action was not successful, it rethrows this exception to the consumer of the 
AC NLS. The consumer of AC may catch LocalizableException if necessary. 

• One LocalizableTextResourceAccessor Bean may be deployed per EJB Server where ACs are deployed. 

• You do not need to set locale and time zone information when deploying AC NLS. 

Update to AC Exception service documentation 
In AC Exception references, the AC Exception (not NLS) support classes are found in the 
com.ibm.wsbc.acs.exception package. 

Updates to the General AC documentation 
In the "Deploy an AC instance" procedure, add the following step as the first step of the first procedure:  

1. Use the AC Deployment Tool to register the AC. You can use the default settings provided by the AC. If 
you change the name of the AC instance or the JNDI name of the AC's Session Bean (the name of the AC 
Function Group), note the new values for these items as you will need them when you deploy the EJBs of 
the AC. 

In the "Deploy the EJBs in the WebSphere Application Server" procedure, replace the text and table in step 5 with 
the following:  

5. In the Create EnterpriseBean window, select the General tab. In the Jar file field, specify the .jar file by 
following these steps:  

a. Click on the Browse button (be prepared to wait a bit). 
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b. Double-click the file you want to deploy. For example, to deploy the ProductCatalog AC, you 
would double-click the ProductCatalogACEJBDeployed.jar file. 

c. Double-click the .ser file for the Bean you want to deploy. For example, if you want to deploy the 
ProductCatalogInterface EJB, double-click the 
com\ibm\wsbc\ac\proCat\ProductCatalogInterface.ser file. 

d. You will be asked, "This jar is not enabled for Work Load Management. Would you like to enable 
it now?" Click No. 

WebSphere Application Server should have automatically filled in the Name and Deployment descriptor 
fields for you. If you changed the name of the AC instance or the JNDI name of the AC's Session Bean 
using the AC Deployment Tool, you must modify the information in the appropriate Deployment desciptor 
fields. 

Note: If you use more than one server to host multiple ACs, ensure that the JNDI home names of each of 
the AC EJBs are different on each server. To do this you may have to change the Deployment descriptor 
fields. 

In the "Add .jar files to the client's classpath" procedure, remove the last step.  

In the "Register an AC instance" procedure, remove step 3. Replace the first sentence of step 4 with the following 
text. 

If the connector Bean (MBeanServerConnectorBean) from AC Services is not already running, 
use the WebSphere Administrator's Console to start it.  

In the "Undeploy an AC instance" procedure, add the following to the end of the final step: 

, and any other directory where you are keeping deployed .jar files. 

Environment 

File system path values in WebSphere Application Server admin.config file 
When setting the values in the WebSphere admin.config file, file system paths should be specified using MS-DOS 
names. For example, a folder named Program Files could have the MS-DOS name Progra~1.  

JDBC 2.0 classes for DB2 
The default DB2 install uses JDBC 1 classes. To use the JDBC 2.0 classes, run the usejdbc2.bat file, which is 
located in the sqllib/java12 directory.  

JNDI names 
For each server, ensure that the JNDI names used do not conflict with each other or with any JNDI subcontext 
names. 

Operating system environment variables 
The installation programs for WSBC Studio and its components may set some operating system environment 
variables as user variables; these variables apply only for the user who ran the particular installation. If you want to 
make these environment variables available to all users, you should convert these to system variables. Depending on 
the particular user variable, you may need to create a system variable with a name that matches the user variable or 
just update the value of the matching system environment variable. 
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WebSphere Fixpack 2 
If Fixpack 2 of WebSphere has been applied and the WebSphere AdminServer no longer starts, try the following 
procedure:  

1. In the WebSphere/AppServer/bin directory, open the admin.config file. 

2. Examine the list of jar files for the com.ibm.ejs.sm.adminServer.jarFile property. If the jar files are 
separated by semi-colons, replace the semi-colons with commas. In addition, make sure that there are no 
spaces in the directory and .jar file names (that is, use DOS names). 

3. Save the file. 

4. Start the WebSphere AdminServer. 

Product Catalog 
When creating products, it is recommended that the user use a single locale to make maintaining translations easier. 
That is, the user creates all products in one locale and provides translations for the product as needed. 

The maximum number of items returned by a search can be specified by user or by the maximumSearchResultSize 
setting in the ACImplementation.xml file for Product Catalog. The setting in the file is the definitive maximum 
value. If the maximum number specified by a user exceeds the value of the maximumSearchResultSize setting, the 
system defaults to the number of items defined by the maximumSearchResultSize. If the maximum number 
specified by a user is smaller than the value of the maximumSearchResultSize setting, the system uses the maximum 
number defined by the user.  

Product Catalog and Customer Profile 
If the maximumSearchResultSize setting is not set or is set to an invalid value such as -1 or a non-numeric value, 
there is no maximum search result size and all of the search results are returned. 

System Management Console 
The System Management Console included in this release provides only basic functionality to manage AC instances, 
using the JMX API and the JMX Instrumentation and Agent Reference Implementation from Sun Microsystems. 

Windows NT not recognizing substitution variables 
If you install WSBC 1.1 and you have substitution variables such as %JAVAHOME% in your PATH or 
CLASSPATH, the problem you may encounter is that the variables are not substituted (for example, if you open a 
command prompt window and check your PATH or CLASSPATH, it may contain %JAVAHOME% rather than the 
appropriate substitution). This is due to a Windows bug, and the fix for the problem is to take the following action: 

1. Open the Start>Settings>Control Panel folder. 

2. Double click the System icon. 

3. Click on the Environment tab. 

4. Click on the variable that is having the problem (such as PATH). 

5. Click in the Value field for this variable as if you are going to make a change but do not actually 
make that change. 

6. Click Set. 

7. Click OK. 
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The above steps refresh the environment settings and the problem will not be seen in the future. Because of this 
problem, do not use substitution variables in your PATH or CLASSPATH. 

WSBC Code Generator  
The WSBC Studio install includes an AC .mdl file that you can use to view a sample of the expected input for the 
WSBC Code Generator when it is generating ACs. You can also use this file to practice running the WSBC Code 
Generator. This file is located in the tools/samples folder. 

If you downloaded the WSBC Studio from the web instead of installing it from a CD, the tool cannot launch the 
online information when you request help. To find information about the WSBC Code Generator, refer to the WSBC 
Code Generator and Modeling Guidelines PDF document (codgentl.pdf), which has the same content as the online 
information.  
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Known limitations and issues 
The following is a list of the known issues and limitations of Version 1.1: 

Customer Profile 

Deadlocking in a multi-user environment 
In a multi-user environment, Version 1.1 of Customer Profile operations may lock each other out. When this 
happens, one will be rolled back and the other will be allowed to proceed. The choice of which one is rolled back is 
arbitrary and is determined by DB2. The rolled-back function can be retried precisely as it was before. 

Multiple datasources 
If you are configuring multiple Customer Profile datasources, the default Admin DB Driver in WebSphere must be 
JTA enabled. While Customer Profile contains a setting that allows you to configure it to access different 
datasources for Person and Enterprise customers, Version 3.5 of the IBM WebSphere has a limitation that prevents 
multiple datasources from being accessed within a single transaction. This means that Person and Enterprise 
customer information must be stored in the same datasource. 

Oracle databases
Known issues exist that will prevent the Customer Profile AC from operating correctly with Oracle databases. These 
issues will be resolved in the first fixpack. If you require assistance prior to release of the first fixpack, contact IBM 
technical support.  

Product Catalog 

Deleting ComparisonPointData and translations 
When you delete a product or category, any ComparisonPointData or translations associated with the product or 
category are not deleted from the datastore. To delete ComparisonPointData, you must use the 
MarkComparisonPointDataForDelete AC function interface. To delete a translation, delete the translation from the 
appropriate localization tables (CATEGORYLOCALE, PRODUCTLOCALE, COMPOINTLOCALE, and 
COMPOINTDATALOCALE).  

Handling missing translated values 
If Version 1.1 of Product Catalog cannot find translated values for dynamic text, it returns null. This means that 
when products are compared, the dynamic text in the comparison point data have the value of null instead of the 
default value of the dynamic text.  

Oracle databases  
Known issues exist that will prevent the Product Catalog AC from operating correctly with Oracle databases. These 
issues will be resolved in the first fixpack. If you require assistance prior to release of the first fixpack, contact IBM 
technical support.  
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Development Environment 

EJB Server times out when running Advanced Components 
To run Advanced Components within VisualAge for Java, modify the EJB Server timeout value as shown in the 
following procedure:  

1. If an EJB server is running the AC, stop it.  

2. In the EJB Server Configuration window, select the EJB Server containing the AC.  

3. Right-click the server and select Properties. 

4. In the Properties dialog, increase the value of the Transaction Timeout setting to a value such as 1200000 
and increase the value of the Transaction Inactivity setting to a value such as 6000000.  

5. Select OK. 

6. Restart the EJB server. 

WSBC tool does not run from the command line 
This problem occurs because the system could not find the java.exe program required to run the WSBC tools (which 
are Java applications). To ensure that the correct JDK is being used: 

1. Open the Control Panel. 

2. Double-click System. 

3. Click the Environment tab. 

4. Select the Path variable. 

5. Prepend the value:  

%JAVA_HOME%\bin; 

6. Click Set. 

7. Create a new variable by typing the following into the Variable text box: 

JAVA_HOME 

For its value, type in the path to the JDK root directory. Examples of paths include c:\Program 
Files\JDK1.2.2 or, for WebSphere, c:\Program Files\WebSphere\Appserver\jdk) 

8. Click Set. 

9. Click Apply and then click OK. 

The JAVA_HOME variable is the way WebSphere sets the JDK. This way, the system always uses the correct JDK 
for the WSBC tool.  
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Product Recommendation Sample 
The Product Recommendation sample runs in the VisualAge for Java environment. It does not run on WebSphere 
outside of VisualAge for Java. To make it run on WebSphere: 

1. Add all of the Product Recommendation Samples *.gif files to the IBM HTTP Server\htdocs directory.  

2. In the same directory, create a directory called theme and add the master.css file to this new directory.  

WSBC Code Generator 
The following section contains limitations and issues that apply when you are generating AC code and issues that 
occur when installing or uninstalling the tool. 

Code generation limitations and issues 
The limitations and issues documented here can apply or occur when you are generating AC code. 

Class not found error 
You may get this error if the model that the WSBC Code Generator maintains in the cache does not reflect the 
changes that have been made to the model. To solve this error, clear the cache by selecting Reset from the Generator 
menu or Clear WSBC Generator Cache from the Tool menu in Rational Rose.  

Directive is not valid warning 
The WSBC Code Generator issues Directive is not valid warnings for #PackageName and #EncapsulatedUsage 
directives when it is reading the model prior to generating code. You can ignore these warnings as the tool uses 
these directives when it generates code.  

Enumeration type support  
The WSBC Code Generator does not support enumeration types. For these types, you will have to manually change 
the generated code and the XML schemas for ACs.  

Help does not launch 
If you downloaded the WSBC Studio from the web instead of installing it from a CD, the tool cannot launch the 
online information when you request help. To find information about the WSBC Code Generator, refer to the WSBC 
Code Generator and Modeling Guidelines PDF document (codgentl.pdf), which has the same content as the online 
information.  

Incorrect package names generated 
If you use the WSBC Code Generation Tool to create an AC that depends on the Customer Profile AC, the Product 
Catalog AC, the Common Parameter Suite, or the Common Customer Suite, you will need to change the generated 
code in the accessors to correct package names. For example, if the new AC depends on the Customer Profile AC, 
you must change the package name of Customer Profile classes in the generated code to com.ibm.wsbc.ac.custProf. 
This is due to a problem with the models for these ACs. 

You can also correct this problem in the model by replacing the #JavaPackage directive with the #PackageName 
directive. 
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Keyed collections support  
The WSBC Code Generator does not support keyed collection types. For these types, you will have to manually 
change the generated code and the XML schemas for ACs.  

Location of the generated XML files 
The WSBC Code Generator GUI does not show the destination of the generated XML files. However, the tool 
places these files (ACDefinition.xml, ACImplementation.xml, Events.xsd, Functions.xsd, InterfaceModels.xsd) in 
the location specified by the Input_Output_Directory setting for the component being generated. 

Messages missing ERROR, WARNING, and INFO prefixes 
When you are running the WSBC Code Generator with the -nogui option enabled, the messages displayed in the 
DOS window are not prefixed with ERROR, WARNING, or INFO. To see what types of messages are being 
produced, inspect the log file produced by the WSBC Code Generator. The messages in this file have the prefixes.  

NullPointerException due to broken references 
The WSBC Code Generator does not handle broken references in the Rose model files. For example, if class A had 
a reference to class B (from a different .cat file) and class B is removed, the WSBC Code Generator throws a 
NullPointerException when it generates class A. To correct this problem, remove all references in the Rose model to 
deleted classes, attributes, and methods.  

NullPointerException due to a changed Rose model file 
The WSBC Code Generator may fail with a NullPointerException if a Rose model file is changed. To prevent this 
from occurring, clear the cache before starting the generator by selecting the Generator menu of the WSBC Code 
Generator and then clicking Reset. 

Operations with the same name 
Within a class, each operation should have a unique name. For each dependent AC Function, the WSBC Code 
Generator generates a command accessor method whose name is based on the operation name. If operation names 
are not unique, the tool does not generate more than one command accessor methods for that name. Non-unique 
operation names may occur when you have multiple AC Functions within the model of an AC Function Group and 
the operations have names that are repeated in one or more of the other AC Functions.  

OutOfMemoryError  
In an attempt to limit the amount of memory it uses, the WSBC Code Generator loads into the working cache only 
the portions of the model it needs for a generation run. For example, if you are generating a class which has 
relationships to classes in five different categories, the WSBC Code Generator loads only the classes in the five .cat 
files (which are Rose controlled units) containing the related classes. However, the working cache is cleared only 
when you exit the generator or when you clear it manually. Depending on how many dependencies the class you are 
generating has and how long it has been since the cache was cleared, the cache may increase to where it can cause 
OutOfMemoryErrors.  

To avoid OutOfMemoryErrors:  

• If you encountered the OutOfMemoryError while generating a single class, clear the cache by exiting the 
generator, by selecting Reset from the Generator menu, or by selecting Clear WSBC Generator Cache 
from the Tool menu in Rational Rose. 
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• If you encountered this error when generating a number of classes or generating a category, either reduce 
the number of classes you are trying to generate, use the -nogui option of the generator, or clear the cache. 

• Increase Java's maximum heap by altering the generator.bat file (via the -Xmx option on the Java 
command).  

Rose model multiplicity not reflected in the generated function and interface model schema files 
The WSBC Code Generator does not generate the multiplicity of collections and arrays contained in the Rose model 
for the Functions.xsd and InterfaceModels.xsd. To correct this, you must change the AC interface models and 
function models in Rose to add the multiplicity to the aggregate relationships for collections, arrays of AC interface 
models, and for collections of simple types.  

Source file overwritten errors 
The WSBC Code Generator may generate Java code for some AC classes twice because of a problem with the AC 
rule templates. You can ignore these messages because the code is completely generated twice (there is no 
difference between the first generation and the second one).  

Unable to generate AC source code or XML from a package  
You cannot generate AC source code or XML from a package even if it is stereotyped as AdvancedComponent. You 
can only generate AC source code or XML from a class with the <AdvancedComponent> stereotype.  

UnknownHostException 
If you encounter an UnknownHostException while running the WSBC Code Generator, verify that TCPIP is 
installed correctly on the machine and there are no TCPIP-related network problems. 

Warning message for Rose models without path maps 
For the WSBC Code Generator, you typically import one or more .cat files into Rose, which would set path maps. If 
the Rose model does not contain any path maps, you will see the following message "No UML path maps: No UML  

WSBC Code Generator does not launch from within Rational Rose 
If you use the Generator menu of the WSBC Code Generator to view or change its preferences and you do not close 
the WSBC Code Generator GUI, the WSBC Code Generator does not launch from within Rational Rose. To launch 
the generator, exit the existing WSBC Code Generator GUI first.  

path maps have been set. Because SanFrancisco uses path maps, the UML scan may not succeed". If the model does 
not have .cat files, ignore this message. 

WSBC Code Generator does not run because the system cannot find the path to the tool 
This problem only occurs if you install the BC part of the WSBC Code Generator (which is downloaded from the 
Web). The WSBC Studio installation creates a environment variable called WSBCTOOLS_PATH. This variable is 
used to locate the part of the WSBC Code Generator that generates AC code. The part of the WSBC Code Generator 
that generates BC code also uses an environment variable called WSBCTOOLS_PATH; however, the installation 
for the BC part of the tool does not set a value for the variable. The problem occurs when the AC part and BC part 
are installed under a different directory structure as the variable can only contain one path.  
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To correct this problem:  

1. Set the value of the WSBCTOOLS_PATH to the directory path of the part of the tool that you want to use.  

For example, if you want to generate BC code and the BC part of the tool is installed in the 
C:\WSBC_WebVer\1.1\tools directory, you must set this variable to 
WSBCTOOLS_PATH=C:\WSBC_WebVer\1.1\tools (the location of the BC part of the tool.) If you want 
to generate AC code and the AC part of the tool is installed in the C:\WSBC\1.1\tools directory, you must 
set this variable to WSBCTOOLS_PATH=C:\WSBC\1.1\tools (the location of the AC part of the tool.)  

Note: the path to the tool you want to use must not contain any spaces. Spaces cause a NoClassDefFound 
error when the WSBC Code Generator is run. To avoid these errors, use DOS names. For example, for 
C:\Program Files\IBM, use C:\Progra~1\IBM. 

2. To run the tool from Rational Rose, set the WSBCTOOLS_PATH Virtual Path Map to point to the part of 
the tool that you want to use: 

a. Open Rational Rose 

b. Go to File > Edit Path Map ... 

c. In the Virtual Path Map dialog, type the following into the Symbol: text box 

WSBCTOOLS_PATH 

In the Actual Path: text box, type the drive and path to the root of the AC or BC part to 
the WSBC Code Generator that you want to use.  

d. Click Add then click Close. 

e. Close Rational Rose 

The Studio installation sets WSBCTOOLS_PATH to point to the AC part of the code. 

Installation Issues 
The following is a list of the known issues related to installing Version 1.1 of the Studio: 

Configure the AC Deployment Tool 
If the system did not have VisualAge for Java for Windows 3.5 when you installed WebSphere Business 
Components Studio, you will have to configure VisualAge in order to run the AC Deployment Tool from the Java 
Tool menu. In the following instructions <WSBCROOT> is the directory you specified for the installation of IBM 
WebSphere Business Components Studio. 

To configure AC Deployment Tool to run from the VisualAge for Java Tool menu, complete the following steps:  

1. Close VisualAge for Java if you currently have it running. 

2. If it is not already present, create a directory "com-ibm-wsbc-actools-deployment" in the directory 
<VAJROOT>\ide\tools. 

3. Extract ACModel.jar and ACToolsDeployment.jar from the <WSBCROOT>\tools\lib directory to the 
directory you just created. 

4. Copy the actools.ini file found in <WSBCROOT>\tools to the directory you created in step 2. 
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5. Edit the actools.ini file so that basepath is set to the directory where settings.xml is found: 
<WSBCROOT>\tools. The basepath should have double slashes as delimiters, and should end in double 
slashes, as in the following example:  
basepath=c:\\Program Files\\ibm\\WSBC\\1.1\\tools\\

6. Copy the default.ini file from the <WSBCROOT>\tools\vaj to the directory you created in step 2. 

Configure the WSBC Code Generator 
If the system did not have WebSphere Application Server Advanced Edition 3.5 or Rational Rose 2000e when 
WebSphere Business Components Studio was installed, you will have to configure the system in order to run the 
WSBC Code Generator. In the following instructions <INSTALLDIRECTORY> is the directory 
<WSBCROOT>\tools. <WSBCROOT> is the directory you specified for the installation of IBM WebSphere 
Business Components Studio. The "Rose program directory" is the directory that contains rose.exe (normally 
C:\Program Files\Rational\Rose). 

To configure the system to run the WSBC Code Generator, complete the following steps:  

1. Copy <INSTALLDIRECTORY>\rose\WSBC_STEREOTYPES.ini into the Rose program directory.  

2. Copy the <INSTALLDIRECTORY>\acstereotypes directory to the Rose program directory.  

3. If you do not have java.exe in your PATH, edit the dataWSBC.properties file, located in the 
<INSTALLDIRECTORY>\data\ directory. Substitute <INSTALLDIRECTORY> in the file with the path 
to the actual directory. The file delimiter should be \\. For example, if the INSTALLDIRECTORY is 
c:\wsbc\ec110\tools, the replacement should be c:\\wsbc\\ec110\\tools. 

4. Edit the generator.bat file located in <INSTALLDIRECTORY>\bin. Replace <WebSphere_Installed> with 
the path of the directory where WebSphere Application Server is installed.  

5. Edit the registry by doing the following typing regedit on a command line. Add the following registry 
entries (keeping the version name identical to that of WSBC): 

a. Open Notepad and copy the following registry entry text into it:  

Note: the following registry entries are different from the registry entries included in the Release 
Notes for the Studio CD. See the table at the end of this procedure for the changes. 

REGEDIT4 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC Generator] 
"Active"="Yes" 
"Company"="International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp, Copyright © 2000 Spin Software LLC." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_COMMON.mnu" 
"InstallDir"="<INSTALLDIR>" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC AC Generator] 
"Active"="Yes" 
"Company"="International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp, Copyright © 2000 Spin Software LLC." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_AC.mnu" 
"InstallDir"="<INSTALLDIR>" 
"OLEServer"="AC_GeneratorAddIn.EventHandler" 
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[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC BC Generator] 
"Active"="Yes" 
"Company"="International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp, Copyright © 2000 Spin Software LLC." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_BC.mnu" 
"InstallDir"="<INSTALLDIR>" 
"OLEServer"="BC_GeneratorAddIn.EventHandler" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC DirectiveAssistant] 
"Active"="Yes" 
"Company"="International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_DA.mnu" 
"InstallDir"="<INSTALLDIR>" 
"OLEServer"="DA_AddIn.EventHandler" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC BC Generator\Events] 
"OnActivate"="Interface" 
"OnDeactivate"="Interface" 
"OnEnableContextMenuItems"="Interface" 
"OnSelectedContextMenuItem"="Interface" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC AC Generator\Events] 
"OnActivate"="Interface" 
"OnDeactivate"="Interface" 
"OnEnableContextMenuItems"="Interface" 
"OnSelectedContextMenuItem"="Interface" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC DirectiveAssistant\Events] 
"OnActivate"="Interface" 
"OnEnableContextMenuItems"="Interface" 
"OnSelectedContextMenuItem"="Interface" 

b. In Notepad, replace <INSTALLDIR> with the location of the tools directory for WSBC. Use \\ for 
the file delimiter. For example, if the INSTALLDIRECTORY is c:\wsbc\ec110\tools, the 
replacement should be c:\\wsbc\\ec110\\tools. 

c. Save the file as a .reg file. Use quotation marks to prevent Notepad from appending .txt to the file 
name.  

d. Make a backup of your current registry. 

e. Start the registry editor (type regedit in a command line). 

f. To import the .reg file, select Registry and then select Import Registry File.... Navigate to the 
file you saved in step c, select it, and then select Open.

6. Update the registry HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\StereotypeCfgFiles 
by adding a new String:  
FileX 
where X is the next available integer.  
The value should be WSBC_STEREOTYPES.ini  
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7. COM Server Entries: Three .dll files need to be registered as COM servers. The files are:  

o <INSTALLDIRECTORY>\bin\BC_GeneratorAddIn.dll  

o <INSTALLDIRECTORY>\bin\AC_GeneratorAddIn.dll  

o <INSTALLDIRECTORY>\bin\DA_AddIn.dll  

8. Register these files by invoking the following command lines or via install shield (if different):  
o regsvr32 /s "<INSTALLDIRECTORY>\bin\BC_GeneratorAddIn.dll"
o regsvr32 /s "<INSTALLDIRECTORY>\bin\AC_GeneratorAddIn.dll"
o regsvr32 /s "<INSTALLDIRECTORY>\bin\DA_AddIn.dll"

9. Update the WSBCTOOLS_PATH environment variable to <INSTALLDIRECTORY>.  

10. Update the PATH variable to include <INSTALLDIRECTORY>\bin. 

Note: The following table shows the difference between the registry entries called for by the Release Notes on the 
Studio CD and the Release Notes that are downloadable from the Internet. The changes are marked in green text.  
 [HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC Generator] 
"Active"="Yes" 
"Company"="IBM International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp, Copyright © 2000 Spin Software LLC." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_COMMON.mnu" 
"InstallDir"="<INSTALLDIR>" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC AC Generator] 
"Active"="Yes" 
"Company"="IBM International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp, Copyright © 2000 Spin Software LLC." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_AC.mnu" 
"InstallDir"="<INSTALLDIR>" 
"OLEServer"="AC_GeneratorAddIn.EventHandler" 
 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC BC Generator] 
"Active"="Yes" 
"Company"="IBM International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp, Copyright © 2000 Spin Software LLC." 
"LanguageAddIn"="No" 
"Version"="1.1.0" 
"MenuFile"="rose\\WSBC_BC.mnu" 
"InstallDir"="<INSTALLDIR>" 
"OLEServer"="BC_GeneratorAddIn.EventHandler" 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rose\AddIns\IBM WSBC DirectiveAssistant] 
"Active"="Yes" 
"Company"="IBM International Business Machines Corporation" 
"Copyright"="Copyright © 2000 IBM Corp." 
"LanguageAddIn"="No" 
"Version"="2 1.1.0" 
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"MenuFile"="rose\\WSBC_DA.mnu" 
"InstallDir"="<INSTALLDIR>" 
"OLEServer"="DA_AddIn.EventHandler" 

Rational Rose Tools menu does not have the WSBC Code Generator 
You should be able to start the WSBC Code Generator from the Tools menu of Rational Rose. If the menu does not 
have this item:  

1. If it is not already installed, install the WSBC Code Generator and restart the computer. 

2. If the Java executable is not in your path, add it by doing the following:  

a. Go to the Control Panel and select System and then select Environment.  

b. In the dialog, select the PATH variable. 

c. Type the path to the java.exe file. 

d. Click Set and then click Apply.  

3. Add the WSBC Code Generator to Rational Rose by doing the following: 

a. From the Rational Rose Add-Ins menu, click Add-in Manager. select IBM WSBC Code 
Generator.. 

b. Select AC Code Generator or BC Code Generator or both.In the list of add-ins, select IBM 
WSBC Code Generator, and either IBM WSBC AC Code Generator or IBM WSBC BC Code 
Generator or both. You can also select IBM WSBC Directive Assistant at this time. 

c. Click Apply.  

The Tools menu will now have an item for the IBM WSBC Generator.  

WSBCTOOLS_PATH environment variable not removed during uninstall  
The Environment variable, WSBCTOOLS_PATH, may not be removed from the Path settings by the uninstall 
program. If this happens, manually remove WSBCTOOLS_PATH from the Path settings.  

AC Deployment Tool 

AC having two states simultaneously 
Before deploying an AC in WebSphere, ensure that the root path for WebSphere is set correctly. If the path is 
incorrect, an error may occur during deployment that results in the tool displaying the AC as having Deployed and 
Undeployed states simultaneously. To check and set the root directory for WebSphere, select the Actions menu and 
then select Set Preferences. For the EJB Server setting, select WebSphere. The path to WebSphere is then displayed 
and is available for editing if necessary. 
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Corrupt XML file in a deployed .jar file 
The .jar file process used by the AC Deployment Tool may corrupt the manifest file in the deployed copy of the . jar 
file. This makes it unusable at runtime. To correct this problem:  

1. Create a copy of the original .jar file and store the copy in the deployment directory. Use the original 
version of the file at runtime. 

2. Run the AC Deployment Tool to create the deployed copy of the .jar file.  

3. To update the AC with any changes made using the AC Deployment Tool, copy the ACDD.xml file from 
the deployed copy of the .jar file to the runtime copy. 

Null pointer exception 
When the AC Deployment Tool verifies a single AC instance, it enables the Deploy AC Instance option on the 
Actions menu. If you select that option without clicking anything on the tree, a null pointer exception occurs and the 
AC Deployment Tool does not deploy the AC. To prevent this, select the AC instance on the tree before selecting 
the Deploy AC Instance option.  
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Notices 
IBM may not offer the products, services, or features discussed in this document in all countries. Consult your local 
IBM representative for information on the products and services currently available in your area. Any reference to 
an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or 
service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM 
intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. The 
furnishing of this document does not give you any license to these patents. You can send license inquiries, in 
writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  

The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties 
in certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the 
information herein; these changes will be incorporated in new editions of the publication. IBM may make 
improvements and/or changes in the product(s) and/or program(s) described in this publication at any time without 
notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for 
this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring 
any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of 
information between independently created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact: 

IBM Canada Ltd., 
Department 071, 
1150 Eglinton Avenue East 
Toronto, Ontario, M3C 1H7 
Canada 

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of 
a fee. 

The licensed program described in this document and all licensed material available for it are provided by IBM 
under terms of the IBM Customer Agreement, IBM International Program License Agreement, or any equivalent 
agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained 
in other operating environments may vary significantly. Some measurements may have been made on development-
level systems and there is no guarantee that these measurements will be the same on generally available systems. 
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Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of 
this document should verify the applicable data for their specific environment. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and 
represent goals and objectives only. 

 

COPYRIGHT LICENSE:  

This information contains sample application programs in source language, which illustrates programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any 
form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for which the sample programs are 
written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or 
imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample 
programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing 
application programs conforming to IBM's application programming interfaces. 

Trademarks and service marks 
The following terms are trademarks of International Business Machines Corporation in the United States, or other 
countries, or both: 
AIX 
CICS 
DB2 
DB2 Universal Database 
e-business 
IBM 
LANDP 
MQSeries 
OS/2 Warp 
OS/390 
RS/6000 
SanFrancisco 
VisualAge 
Visual Banker 
WebSphere 
 
Lotus, Domino, Lotus Notes, and Notes Mail are trademarks of the Lotus Development Corporation in the United 
States, other countries, or both. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in 
the United States, other countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United 
States, other countries, or both. 

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel Corporation in the United States, 
other countries, or both. 

UNIX is a registered trademark in the United States, other countries, or both and is licensed exclusively through 
X/Open Company Limited.  

Rational Rose is a registered trademark of Rational Software Corporation. 

Other company, product, and service names may be trademarks or service marks of others. 
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